
Aldus  1.5 Classic Art, Volume 1
System Requirements and Installation

System Requirements 
The Gallery Effects application and the Classic Art, 
Volume 1 effects require Microsoft Windows 3.0 (or later)
and Microsoft Windows 3.0- compatible hardware.    The 
application and the effects will run under Microsoft 
Windows standard or enhanced mode.

Recommended: A 386_ or 486_based DOS-compatible 
computer 4MB of RAM, an 80MB hard disk, a 16or 24_bit 
graphics card and monitor, and a mouse or other 
pointing device.

Minimum: A 386-based DOS compatible computer 4MB 
of RAM a 20MB hard disk any color Windows-compatible 
graphics display card and monitors, and a mouse.

For using the effects within Aldus PhotoStyler  1.1, 
Fractal Design Painter or other programs that use 
PhotoStyler-compatible plug-in filters, please refer to 
their respective system requirements.



Memory Requirements

Electronic images can be very large in terms of disk 
space. A scanned 8 x 10_inch color photograph can 
require more than 7 megabytes of disk space.    In 
addition to disk space, your system will need enough 
random access memory (RAM) to accommodate such 
large images.

The Gallery Effects application is designed to handle 
large graphics files like this easily because it uses 
Windows' virtual memory. Virtual memory means that if 
an image is too large for your system's RAM to handle, 
hard disk space is used to augment RAM and 
accommodate large files.

If the amount of disk space that has been allocated for 
virtual memory is not enough, then you need to increase
it Using Windows' Control Panel. A thumb rule to 
determine how much memory you need is to multiply 
the uncompressed image's file size by 3.    For example, if
the image is 500K, you will need at least I,500K memory. 
If the image is compressed, you will need even more 
memory.



Installation Instructions
The Aldus Gallery Effects 1.5 application the Classic Art 
Volume 1 effects and asociated files are provided in 
compressed format.    None of the files are usable until 
you decompress them with the Installer.    The automated
installation process requires a hard disk.    To install the 
files on your hard disk you will need at Ieast 3.1 MB of 
disk space available.

 The installation process overwrites the COMMDLG.DLL file in the System directory within the Windows 
directory.    If you are running Windows over a network, you should have the network administrator temporarily 
disable the write protection, install Gallery Effects, and then enable the write protection after installation.    Also, if 
you have problems while installing Gallery Effects, you should turn off memory-resident programs such as virus 
checkers.

To install the Gallery Effects application and the Classic 
Art, Volume 1 effects:

1. Turn on your computer, start Microsoft Windows, open 
the Program Manager.    If you don't know how to use 
Microsott Windows or are unsure about specific functions
consult the Microsoft Windows User's Guide.

2. Insert Disk 1 into the disk drive.

3. Choose Run from the File menu.

Ths Run dialog box appears.



4. In the Command Line text box, type A:\ALDSETUP (or 
B:\ALDSETUP if you inserted the disk into drive B in step 
2) and click OK

5. If there are no other Aldus products installed on the 
hard disk, the Select directory dialog box appears;

 If there are other Aldus products installed on the hard disk, the installer skips to the next step.

6 The Aldus Setup Main Window appears; click Setup.

This starts the Gallery Effects installation process and opens the Select directory dialog box.

7. If you want to install Gallery Effects on a different disk, replace "C" with the letter that 
corresponds to that disk drive.



8. Follow the on-screen instructions and insert disks as prompted.    Click OK to continue 
copying files to your hard disk.

9. When the installation process is completed, the Setup complete dialog box appears; click 
OK.

10. In the Aldus Setup Main Window, click Exit.

11. An alert dialog box appears telling you that the AUTOEXEC.BAT file has been changed; 
click OK.

12. Exit Windows and restart your computer before running the Gallery Effects application.

 Be sure to read the README.TXT file for useful information on Gallery Effects, including information on using
the free Gallery Effects: Classic Art, Volume 2 and Gallery Effects Texture Art samplers.

To Open the Gallery Effects Application:

1. Start Microsoft Windows.
The Gallery Effects program icon appears in the Aldus 
group window.

2. Double-click the Gallery Effects 1.5 icon.



After personalizing the application (the first time you use it), you are now ready to use the 
Classic Art,. Volume 1 effects from within the Gallery Effects application.    After the Aldus 
Gallery Effects startup screen appears, the open dialog box appears, allowing you to open an
image or create a new document.

For detailed information on using the Gallery Effects 
application, see the Gallery Effects User Manual; for 
information on applying and using the effects, see the 
Using Classic Art, Volume 1 manual.

Installing the Plug-in Filters Into Other 
Graphics Programs
To use the effects within Aldus PhotoStyler 1.1 (or later), 
Fractal Design Painter or other programs that use 
PhotoStyler-compatible plug-in filters, you can either 
copy or move the effects into the graphic program's 
directory.    If you copy the effects, you will also be able 
to use them from within the Aldus Gallery Effects 
application.    If you move the effects into the graphic 
programs directory, you will not be able to use them 
from within the Gallery Effects application.

To install the Aldus Gallery Effects: Classic Art, Volume 1 
filters within other graphics programs:

1. After installing Gallery Effects using the installation 
procedure described above, open the File Manager.

2. Open the CLASSIC.GE directory.

3. Open the GE_POUCH directory within the CLASSIC.GE 
directory.

4. Move or copy (press Ctrl and drag) the PLUG_IN 
directory from the CLASSIC.GE directory into the host 
program's directory:

·    For Aldus PhotoStyler, the PSTYLER directory.

·    For Fractal Design Painter, the PAINTER directory.

·    For other programs that use PhotosStyler-compatible 
plug-in filters, the process is similar.    Refer to the user 
manual of the respective graphics program for exact 
instructions.

5. Close the File Manager, exit Windows, then restart 
your computer.

About the Installed Files
·    GALLERY.EXE is the Aldus Gallery Effects 1.5 
application.



·    IMAGE.TlF is a sample image to which you can apply 
the effects.    It is the same image that appears on the 
Gallery Effects: Classic Art, Volume 1 Visual Guide.

·    README.TXT contains useful information that you 
should read.

·    GALLERY.HLP contains the on-line help information for 
the Aldus Gallery Effects application.

·    .EFF files are the effect filters, including FREE Aldus 
Gallery Effects: Classic Art, Volume 2 and Gallery Effects:
Texture Art samplers.

·    CLASSIC.HLP contains the on-line help information for 
the effects.

·    ALDUS directory contains essential files that the 
effects and the Aldus Gallery Effects application use.

·    TEXTURE.ART directory contains sample low-resolution
textures from Aldus Gallery Effects: Texture Art.



To go to any of the following topics, click on its title:

    System Requirements

    Memory Requirements

    Installation Instructions

          Installing Plug-in Filters
          About Installed Files
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all other Windows applications.

To run Gallery Effects Classic Art under Microsoft Windows, you 
need to license and install Microsoft Windows

Aldus Corporation Consumer Division
9770 Carroll Center Rd., Suite J
San Diego, CA 92126-4551

For service and support in the United States please call Aldus 
Consumer Division at (619) 695- 6956.    For service and support
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Introduction to Classic Art, Volume 1

Welcome to Aldus Gallery Effects: Classic Art, Volume 1, 
the heart of the growing Gallery Effects family of 
stunning artistic effects.    Gallery Effects is a library of 
artistic effects that you can apply to scanned 
photographs and other bitmapped images to transform 
them quickly and automatically into sophisticated works 
of art.

With Gallery Effects, you can transform any bitmapped 
image, including color and gray-scale scans, into brilliant
art. Even if you're not a highly skilled computer artist, 
Gallery Effects simplifies the process of applying 
advanced and creative effects to images so that you can 
achieve impressive, consistent results quickly and easily. 
With Gallery Effects, you can add life to all your printed 
and electronic documents.



About the Effects

Gallery Effects: Classic Art, Volume I contains 16 artistic 
effects, each specially designed to recreate a classic art 
style you can apply to an image.    You can see samples 
of the effects on the accompanying Visual Guide.    You 
use Gallery Effects as filters within a host application to 
enhance either an entire image or a selected area.    Use 
them singly or in combination with other Gallery Effects 
filters.

The 16 effects included in Classic Art, Volume 1 include:

·    Chalk and Charcoal ·    Fresco
·    Charcoal ·    Graphic Pen
·    Chrome ·    Mosaic
·    Craquelure ·    Poster Edges
·    Dark Strokes ·    Ripple
·    Dry Brush ·    Smudge Stick
·    Emboss ·    Spatter
·    Film Grain ·    Watercolor

Each of the 16 effects is actually a "plug-in" filter that 
lets you apply that artistic enhancement to an image.    
They are called ''plug-ins'' because you can plug them 
into any of several graphics programs that recognize the 
plug_in filter format, so they appear as an integral part 
of the program.

Applying the effects takes only minutes.    Individual 
adjustable controls let you produce literally thousands of 
variations to create sophisticated computer-generated 
images.    To apply an effect, simply open a bitmapped 
image, select an effect, and click. That's it!

Integration with other programs
You can access the Gallery Effects plug-in filters directly 
from within the image-processing software you are 
already using, allowing you to work in your familiar 
graphics environment without Iearning another program. 
The plug-ins work with Aldus , Fractal Design 

Painter  graphics programs that use PhotoStyler-compatible plug_ins.

Gallery Effects application 
Even if you don't use these graphics programs, you can 
apply the effects to your images by accessing the plug-in
filters with the Gallery Effects stand-alone application, 
included in this package.    This application allows you to 
open graphics files in TIFF (.TIF), TARGA (.TGA) and 
bitmapped (.BMP) formats, preview an effect, customize 
it, apply it, and then save or print the image.



For detailed information on using the Gallery Effects 
application, see the Gallery Effects User Manual, 
included in this package.

Special features
In addition to flexibility, Gallery Effects offers 
consistency: when you switch from one program to 
another, you don't have to worry about learning different
ways to apply the same effect.    Regardless of which 
program you use, when you apply the same effect, the 
same dialog box appears.    In fact, the general 
appearance of this dialog box is the same for each 
effect--only the individual controls for adjusting the 
effect    vary.

Previews
Gallery Effects gives you the freedom to experiment.    
Whichever way you use it, Gallery Effects lets you see 
the image before and after the effect is applied.    Since 
you can see how the effect changes the image as you 
work, you apply the effect only when you know it's 
exactly the way you way you want it.

Customizing
You can customize any of the effects to achieve the results you want.    The individual 
controls allow you to alter settings for each effect.    Once you've set up an effect the way 
you want it you can save the control settings when, for example you'd like a consistent look 
across a set of images.    Later you can apply the same effect with the same settings to a 



different image by simply selecting these settings from the drop-down list box. You can save 
up to 25 control settings for each effect.



Applications and Uses

Gallery Effects will add life to your documents and 
impact to your work in many ways.    You can use the 
effects for:

Creating artwork--apply the effects to scanned 
photographs or original painted images.

Photo retouching and enhancement--add artistic 
touches, refine and enhance photographs.

Desktop publishing--add impact to scanned photographs 
for use in newsletters, brochures, handbooks, 
magazines, annual reports, advertisements, and more.

Presentations, multimedia and video--lend vitality to 
photographs for use in desktop presentations, 
multimedia, and video productions.

Architecture--apply the effects to architectural 
photographs or 3D renderings to create painted visual 
concepts.

Background textures--apply the effects to solid 
background colors to create unique custom textures.



To go to any of the following topics, click on its title:

    About the Effects

          Integration with other programs
          Gallery Effects Application
          Special Features

    Application and Uses





Using the Effects

This section describes how to access preview and apply 
the effects and save and use customized control settings
for each effect.



Accessing, Previewing and Applying the 
Effects

Once installed the individual effects are located in a 
cascading menu from the host program's appropriate 
menu.    When you choose an effect, the same dialog box
for the chosen effect opens, regardless of the host 
application.    Within that dialog box the individual setting
controls vary depending on the effect you selected.

To access, preview and apply the effects:

1. Open the Gallery Effects application or other 
application in which you've installed the Gallery Effects 
plug-in filters.

2. Open the document to which you want to apply the 
effect, or paste the bitmapped image to which you want 
to apply an effect into a new document.

    For best results you may want to optimize the appearance of your image prior to applying an effect by using 
the brightness and contrast or color balance image controls in your host application.

For information on using the Brightness and Contrast or Color Balance image controls that 
come with the Classic Art Volume 1 package see the Gallery Effects User Manuals

3. If you want to apply an effect to only a portion of the 
image, select an area using one of the program's 
selection tools.

4. Choose the effect you want from the appropriate 
menu.

·    In the Gallery Effects application, choose an effect 
from the Gallery Effects: Classic Art cascading menu 
from the Effects menu.

OR

Choose All Effects to open the Effects dialog box.

    Click on the areas outlined in green for more information



Select an effect from the list to see a sample.    To get information about an effect, click Help. 
To use a selected effect, click Open or double-click the name of the effect you want.

·    In PhotoStyler, choose an effect from the Gallery Effects: Classic Art cascading menu in 
the Image menu.

·    In Fractal Design Painter, choose an effect from the 
Filter cascading menu in the Edit menu.

Note: For information about accessing plug-in filters in other host 
applications, consult their respective user manuals.

The Effect Settings dialog box for the effect opens ready 
for you to apply the effect.    The image is displayed in 
the left frame as a thumbnail view of the original image 
or selection.

You can preview the effect on a selected portion of the 
image before applying it.    The following illustration 
shows you how to preview an effect, make changes to 
the control settings and preview those changes.

    Click on the areas outlined in green for more information



5. Drag the preview frame over the part of the image you want to preview. The area within 
the frame appears in the box labeled Before.

6. Click Preview to preview the effect.

Previews correspond as closely as possible to how the effect will look when applied to the full
image or selection.    However, the final result is highly dependent upon the particular image.
To obtain a more comprehensive view of the final result, preview several different areas of 
the image before applying the effect to the entire image.

Adjust the controls to experiment with different settings. 
Each time you adjust the controls, click Preview to see 
the effect of the new settings.    For specific information 
on the individual controls for each effect, click Help.

You can also save the current slider settings or apply 
previous stored settings.

    For more information, see "Saving and Using Stored Control Settings"
in this manual.

7. When the effect is the way you want it, click Apply to 
apply the effect to your image or selection.

A progress indicator dialog box appears.    Depending on 
the size of the image and the complexity of the effect, it 
may take several seconds to several minutes to apply 
the effect.

Click Cancel to close the dialog box without applying the 



effect.

 Use the various selection or masking tools available in the specific graphics programs to apply several effects 
(or the same effect with different settings) to different parts of the same image.



Saving and Using Stored Control Settings

Once you've customized an effect using the control 
settings, you may want to save the settings in order to 
apply the same effect to another image later.    This is 
particularly useful if you have a series of images that 
require a consistent look and feel.    Gallery Effects lets 
you save up to 25 settings for each effect.    The settings 
are stored with the specific effect, so you don't have to 
worry about "misplacing" the settings.    The Saved 
Settings drop-down list box displays the list of saved 
settings for each effect.

Saving control settings 
After you've customized an effect, save the control slider
settings and use them when you want to apply the same
effect to another image.

To save control settings:

1. While in the Effect Settings dialog box, adjust the 
controls for the desired effect.

2. Click Save As.    The Save Settings dialog box appears.

3. Type a name for the settings.

4. Click Save.    The name of the new settings is added to the drop-down list box in the dialog
box.



Applying a saved setting
The Saved Settings drop-down list box lists up to 25 
control settings that have been saved for that effect.    
You call apply any of these settings at any time.

To apply a saved setting:

1. Choose the setting from the drop-down list box.    The 
individual controls change to reflect the settings that 
were stored.

2. Click Preview to view the effect.    You can continue to 
choose, preview and edit the stored settings.

3. When you're satisfied with the effect, click Apply.

Changing a saved setting 
You might save a control setting, then decide later that 
you want to change it.

To change a saved setting:

1 Choose the setting you want to change from the drop-
down list box.

2. Adjust the controls.

3. Click Save to save the new settings with the old name. (If you're modifying the default 
settings, only the Save As button is available.)

or

To keep the old settings and save the new settings under a new name, click Save As.    When 
the Save As dialog box opens, type the new name, then click Save.    The new settings 
replace the old settings.



Restoring defaults
You can reset the controls to their original, default 
settings.

To restore the default settings:

·    Choose Defaults from the Saved Settings drop-down 
list box to          restore the controls to their original 
settings.

Removing saved settings
You can remove any saved settings that you don't use.

To remove a saved setting:

1. Select the setting you want to remove from the drop-
down list box. 

2. Click Remove.    An alert box appears asking if you 
really want to remove the settings .

3. Click Remove to erase the settings, or click Cancel if 
you change your mind.



Click to get information on the selected effect.



Display the result of the selected effect on a sample image.



Click to open the Effects Settings dialog box.



Drag the preview frame to the part you want to preview.



The original image or selection.



Use the controls to adjust the effect.



Displays the part of the original image within the preview frame.



Displays the image within the preview frame with the effect applied to it.



Click to preview the effect.



Click to save a custom setting.



Click to remove selected setting.



Click to apply the effect.



These numbers reflect the control settings and change as the controls change.



Click to get information on the effect.



Click to close the dialog box without applying the effect.



To go to any of the following topics, click on its title:
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          Applying a Saved Setting
          Changing a Saved Setting
          Restoring Defaults
          Removing Saved Settings
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